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Volt MX Iris

Launch your First Mobile App
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Volt MX Iriszike&sU. FANPZhD> hTO1>

B volt MX Iris = O x

Project Edit Build Debug Forge Window Help

E2

@ Project

DESIGN PROPERTIES

-4 HCL Volt MX

Sign in

Izl‘ osamu.usui@xxxcom

Default Library

Forgot Password?

Create Account

Console
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Volt MX Iris

Project Edit Build Debug Forge Window Help

BUILD YOUR FIRST MOBILE APP

Create o mobile app incredibly fast, without coding. Learn how to drag and drop Ul (user interface) clements into an app, integrate your app with backend
data, and secure your app with an authentication mechanism.

"Launch your
First Mobile App"
Z ECEf

Launch your First Mobile App
Open a native
it on your rr

app and preview

1l Steps [ 11 Mins

#Onnect App Ul to Data

LQnnec

App Ul to the data

s / 20 Mins

and Share the App

> Violt MX App to previ
nts app on a mohbile de

Zps /10 Mins
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Create Ul from Collections
er interface for an app

19 Steps [ 20 Mins

Creating Details Screen and Delete Reci|
ting Details Screen and Add Delete

> Test Record

native app

[ 20 Mins

Add Authentication

Secure an app's
authentication

awith a user-
iechanism.

/15 Mins

Add Create Recipient

the capability to create a new

34 Steps [ 32 Mins

Publish App to Enterprise Store

Learn how to

Em

7 Steps |

Jublish an app to an
store

0 Mins

Creating Services for the Back-end Datc

for the back-end data

Create servic

1l Steps [ 10 Mins

Add Edit Recipient

ility to edit the

37 Steps [ 36 Mins
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Launch your First Mobile App
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Volt MX Iris

Project Edit Build Debug Forge Window Help

HIKES / Launch your First Mobile App

Copyright © 2022 HCL Technologies Limited | www.hcltechsw.com

Launch your First Mobile App

Hike Version: 1.0

Open a native mobile app and preview it on your mobile device.
Platform Version Categories

ris 9.2 Build Your First Mobile App
11 Steps - 1 Mins

This learning module is a Volt MX HIKE. A HIKE is an interactive tour inside Volt MX Iris that guides you through
step-by-step process of each module. You can access the HIKES catalog by clicking the Hike icon in the Iris
toolbar:

Learn how to:

* Import a sample native app that shows lists of Accounts and Recipients
+ Preview the sample app on a mobile device

Please follow all instructions on hike to successfully complete the tutorial.

7

£ HCL SOFTWARE



l o [ o= A=

Welcome to Volt MX Iris

Volt MX Iris

Project Edit Build Debug Forge Window Help

Q & HCL Japan - osamu.usui ..‘ Osamu Usui

ple v STORYBOARD DESIGN DATA & SERVICES

Default Library 11y Libraries Mobile Refresh —

- Buttons
~ Bution IPLE SER

JECT SE
rButtonR
Welcome to Volt MX Iris
BorderButtonRound

Let's get started!

HyperLinkButton

started

Volt MX App on your
om the Google Play Store ¢
[‘:._ o th
here

Round|

1Hoaa a cl L

on of the extra

When you are ready, click Start!

Bt Bamon 3 Bumn 3
Console ch B Deb
SquaredButtonTriple

0 Project 'S open

€ eroject open time: 5.

€ problem reading git details
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(1/11) Welcome to Volt MX Iris | ki da 2P, |

Welcome to Volt MX Iris
Let's get started!

In this hike, we will:

 Import a sample native app that shows lists of
Accounts and Recipients.

* Preview the sample app on a mobile device.

Before you get started,
* Install the Volt MX App on your mobile device from
the Google Play Store or the App Store.

« Download and extract the sample csv file from here.

Note the location of the extracted file.
When you are ready, click Start!
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Volt MX IrisN&S €

<H. FUDBFRLELD

CDI\AF2TTIE. RO EZITVET,
PRI NEREBEBDIUA NERRT D, BTILDFR
AT TFTV%EAIR—KBUET,
BTV T Uz, BINAILTINAATTLEZ—-UE
9,

iasbDHIIC
Google Play Storez/z(ZApp Storeh's. E/NAILFT
INA RX(Volt MXFPTUZ=A > A M—=)LUET,
B> T)LDesvI 7 A )V ChsF o> O0—-RU. &
BRBUEXT, BBRUETD 7AILDGBFRIZAXAELTHEEET,
#EhTERES, Start ! #ZOVUvVIUEYT,
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http://127.0.0.1:3000/desktopweb/index.html
https://raw.githubusercontent.com/HCL-TECH-SOFTWARE/volt-mx-tutorials/master/public/samples/SampleCSV.zip
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https://raw.githubusercontent.com/HCL-TECH-SOFTWARE/volt-mx-tutorials/master/public/samples/SampleCSV.zip

E=EIl EFHE BE= UEPS

! SampleCSVzip 2022/08/01 20:12 4% (zip =) 74... 1KB

ta *» SampleCSV >

== EiHE EE H4X
exportUsers.csv 2022/08/01 2017 Microsoft Excel C5... 1 KB
A B C D E F G R LU C
] | ] ] ]
Email First Nam: Last Nam¢Phone Password Status Groups / NS TR
john.doe@woodburn.com John Doe VoltMX@123 active Members —\
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https://raw.githubusercontent.com/HCL-TECH-SOFTWARE/volt-mx-tutorials/master/public/samples/SampleCSV.zip

(2/11) Import the Native App

FATF1ITPITVERAIR—NTS

Import the Native App

1.

S WN

From the main menu of the Iris, navigate to
Forge > Browse.

The Volt MX Marketplace windows appears
after logging in.

On the search bar, enter Recipients Mobile.
Click the search icon .

In the list that appears, select Recipients
Mobile.

The details of the Recipients Mobile appear.
Click Import to Workspace.

It may take some time for Iris to import the
app.

If you have imported this project before, the
overwrite error dialog may appear, click OK
button to proceed.

Click the Continue button.

' Copyright © 2022 HCL Technologies Limited | www.hcltechsw.com
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EEFIEIRBEZESR U TLIZS)

Iris DAA>A_1—m5. [Forge] >
[Browse] (C&81LFET,

O/ >%. Volt MX Marketplace 7> K™
MEJRENET,

#%%z)\—C. Recipients Mobile EAHUET,
BRE77A1> 20w I ULET,

%FR%\'MTC ) X . Recipients Mobile %R
LET,

Recipients Mobile DsFliHNRRENFE T
[Import to Workspace] #z20Uwv IO ULET,

Iris N7 T UZA 2 R— N BDICEHEA NN D15
et nET,
BallccoO> o A2 iR— MUz ENSHD
BigE. FEESIS—HF77OTNFRRESNDICE
MO FERIH. [OK] R ZTUw O LUTRISE
HET,

[Continue|/NF>Z0UwvIULET,
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AZ=1—h'5 Forge > Browse Z&iEiR

Volt MX Iris -
Build Debug

Project Edit Forge Window Help

E t:i & HCL Japan - osamu.usui & Osamu Usui

. Sa B STORYBOARD DESIGN DATA & SERVICES
Ig Forge Window Default Library

v Buttons

Mobile

PLE SER\

Browse 5 > PROJECT SERV

Import the Native App

1. Fro main nu of the Iris, na
Forge > Browse

Drag Templates, Data or Create The Volt MX Markerplace indows

RoundFloatingButto. Custom

enter Recipients Mobile
4. In the list ect Recipients
Mobile
The Is of the Recipients Mabile a
5 ck Import to Workspace
It may take some time for Iris to import the

gned pp

Console Searc
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B voit MX Iris = X
Project Edit Builld Debug Forge Window Help

Volt MX Iris

HCL Volt MX

Import the Native App
Sign in to your account
1. From the main menu of the Iris, na
Forge > Brow
The Volt MX Marketplace windows appears
e lreirats

0samu uaui@xxx,(om

nter Recipients Mobile

s, select Recipients

Forgot Password?

Create Account

the Continue button
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1##%58)\—TC Recipients Mobile &5 U Ti#ER

B voit MX Iris = X
Project Edit Build Debug Forge Window

Help

Volt MX Iris

Recipients Mobile

HCL Marketplace

Recipients Mobile

® ®

Import the Native App

=yge / Recipients Mobile

-Recipients Mobile

Recipients Mobile

77TV E IR

1. From the main menu of the Iris, na gate 1c

F’ Forge > Browse
The Volt MX Marketplace windows appears

Google Analytics , : ch bar, enter Recipients Mabile

"

Recipients Mobile Recipients Web Google Analytics Code ... Google Sheets Collection Empl ,{.-D‘m"e R

s, select Recipients

By: HCL Volt MX Team By: HCL Volt MX Team By: HCL Volt MX Team By: Gaurav Rajoric By: HC 1e details of the Recipients Mobile appea
5. Click Import to Workspace

veb Th

le Analytics is on library

tracks and [ore builcing blocks to

r Go

1 35 Qo

the Continue button
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Project Edit Build Debug Forge Window Help

Import To Workspace

(AN

Volt MX Iris

Forge / Recipients Mobile / Recipients Mobile

i 4 ™
Details Import To Workspace ( QO lke )
S /
Asset Version:1.0.1
E LG WETIZGR O, 20 Import the Native App 5= N =182
By: HCL Volt MX Team = 273
is an easily prev of a basic money trans| ) o e P et e (T (e .
Y From the main menu of the Iris, na
) or accounts and recipients, and detail Foes Brores ' CO ntl n U e
with configured identity and object services. The Volt MX Marketplace windows ap
| — ] Requirements Devices Plati : i ¢ enter Recipients Mobile
{ L. con () I \
L Volt MX Iris

Live preview the a

App Preview Code "The "RecipientsiMobile” project contains services that need to be impor

into the Foundry workspace" Do you want to import the services or skip

Do not show this again Skip
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B volt MX Iris
Project Edit Build Debug Forge Window Help

|
o
X

Volt MX Iris Import the Native App

App RecipientsMobile has been successfully imported to your 1. From t

workspace. Please switch project to start working on it. Forge > Browse
The Volt MX Marketplace winc

“ On the bar, enter Recipients Mobile

elect Recipients

f the Recipients Mobile appear

5. Click Import to Works

7 ck the Continue button
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(3/11)0Open the App
Open the App

1.After the app is imported, a Volt MX Iris dialog
appears.
Click OK.

2.From the main menu of the Iris, navigate
to Project > Open > HCL Reference Architecture,
and select RecipientsMobile.
The application opens in the Storyboard view.

' Copyright © 2022 HCL Technologies Limited | www.hcltechsw.com
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7IVzm<

1. 7TURA>ZIR—bhaEna&. Volt MX Iris D
A TFOTNERRESNDBDT, OK 20w
LET,

2. Iris DAXAA>2AZ_1—m5. Project > Open
> HCL Reference Architecture &iE#.
RecipientsMobile &R 3 &, 7TUN
Storyboard E1—THZEZX9,
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I VUZH< (BCHIMNTNSIESEIRISED)

B volt MX Iris
Project Edit Build Debug Forge Window

X

Help

Project >
Open >

New Project Alt+N _Japan-osamu.usui & Osamu Usui

Open > Refresh

el oy ————— HCL Reference Architecture >
oeee B RecipientsMobile
e BCHEM TGS

o e iy . - 1EFRA%(C" RecipientsMobile "
. WRRESNFEE Ao
RICEHFET

Import Cordova Project

Switch Workspace

PaddedButtonRound RoundFloatingButton

e

RoundFloatingButto... SquaredBorderedBut.. Drag Templates, Data or Create
Custol
SquaredBorderedBut SqL BorderedBut
B

SquaredBorderedBut SquaredButton Open the APP

borted, a Volt MX Iris dialog

Click OK
SquaredButtonTriple 2. From the main menu of the Iris, navigate to
Project > Open > HCL Reference Architecture
and select RecipientsMobile

v Carousels

2IRY RN

plication opens in the Storyboard vie

Console Search Build Debug Test T

Copyright © 2022 HCL Technologies Limited | www.hcltechsw.com 18 4= HCL SOFTWARE
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Storyboard E1—hHEFET

B volt MX Iris = X
Project Edit Build Debug Forge Window Help

| - & acx) | 2 & HCL Japan - osamu.usui & Osamu Usui
STORYBOARD DESIGN DATA & SERVICES

Default Library Libra Mobile t Foundry Back RecipientsMobile Refresh —

v Buttons

frmRecipien

RecipientsMobile
HEIREN TS
C &= HERR

Round

JorderedBut

Open the App

1. After the app is imported, a Volt MX Iris dialog

Bant  Bam? ) ick OK

dButtonTriple 2. From the main menu of the Iris, n

Project > Open > HCL Reference Architecture
and select RecipientsMobile

Console Sea
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(4/11) Explore the App

Explore the App

Once the application is imported, you can explore the
different forms in the application.

You can view the forms in two different views:
The Storyboard view and the Design view.

The application opens in the Storyboard view. You
can view the different forms inside the app and
connections between forms in the Storyboard view.

To view Properties of each widget in a form, double

click on any form to open the form in the Design View.

You can also select the Design tab to navigate to the
Design View.

' Copyright © 2022 HCL Technologies Limited | www.hcltechsw.com
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PIVT—>3>&RETD

IV —2 3> A R—kuies, 77U —23
CADESITEFTRIA—LZIFERITDICENTEFET,
JA—AIE. 2DDERIRBEI—THERRIDCENTE
*9, StoryboardE1—&DesignE1—T9,

7TV —23>(d, StoryboardtE 1 —THNMNE T,
StoryboardE 1 —TI(&. ZTUH— 3> AHADETES
FIRITA— LT+ — LAEDEGZHR CSFI .

IA—=LADET Ty bDITONFTAZRTIDIC
(&, EBDITA—LZDTINIIVvIULT, TDIA—
LZEDesigntE 1 —THRWTLEE0, KT,
[Design] #JZERLU A E1—(CRETS
CEBETEFT,
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StoryboardE1— P~ 3 SR
| SXSFRITA LT A —ALBD
S— ERERECEET

STORYBOARD - S1G DATA & SERVICES

Default Library

v Buitons

Explore the App
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.samu.usui

1tsMobile

Storyboard view and the

Butto

Bant s
edButtonTriple 0 View Pmperties 0
ble clic
Design View
to navigate to the

Console

Copyright © 2022 HCL Technologies Limited | www.hcltechsw.com

:. Osamu Usui

Refresh

ct the Design tab
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DeS|gnt:L IA—LRNDET4>TY bD
B Vo NETEEARRESNET — X

Project Edit Build Debug Forge Window Help

- LAY w» nuLvapan - usemu.usui | & Osamu Usui
DESIGN  frmRecipientDetails DATA & SERVICES

Project &5 [ BVR Apple-i0S : Native iPhone 11 (828 x 1792) RecipientsMobile Refresh
~ Mobile
) LE SER
> PROJEC
Forms
frr

frmEditRecipient
o . RECIPIENT DETAILS 74
frmRecipientDetails

FirstName
LastName

NickName

Explore the App

Delete

0 view Properties o
3. double clic form to the form in the
fecouniE I el s e Design View elect the Design tab

to navigate to th

Console
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(5/11) Explore the App

Explore the App

In the Design View, to view the different forms
inside the app, navigate to the Project explorer,
and expand Mobile > Forms.

You can see six forms inside the app. Click on
each form and see what the canvas displays.

' Copyright © 2022 HCL Technologies Limited | www.hcltechsw.com
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[ CNEF1— NI TILOSERTY ]

EEFIRIRBEZSRUTLIZS0)

7TV DIRFE

DesignEa1—T. ZTUANDETEELERIA—LZ
FRIBICIF, TJOZTHORIORTO-S(CEH
L. [Mobile]l] > [Forms] #EREULZE,

VIURIC6DD I A — LD KRFRENET, I A—
') IL., v )\ RICRRSNDNE=TE
BULFET,
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B voit MX Iris
Project  Edit

Project

[ ] frimAddRecipient
[] frmEditRecipient

pientDetails

Mobile] > [Forms] Z=EMH
R DI A —  ILADOANSZHE

T TabP
Button
ndar
CheckBoxGroup

aGrid

Build Debug Forge Window

DESIGN

BVR  Appleios: Native

iPhone 11 (828 x 1792

More

Console
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frmAddRecipient

a1

& 416XJ & HCL Japan - osamu.usui & Osamu Usui
DATA & SERVICES

RecipientsMobile Refresh

B voit MX Iris

Project ~Edit

Build

Debug Forge Window Help

& 416XJ & HCL Japan-osamu.usui & Osamu Usui

DESIGN frmUserLogin DATA & SERVICES

et BVR  AppleiOS: Native iPhone 11 (828 x 1792) RecipientsMobile Refresh =

Mobile

[7] frmEditRecipient
[=] frmRecipientDetails
frmRecipie

frmUserLogin

> | Modules
> [ web

Other Resources
Default Library

v Default

Explore the App

Design View, t

j Project

Mobile > Forms.

oButtonGroup

RichText

Slider Console
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(6/11) Add Sample User [ MEEFIBDREESRBUTL RS ]
Add Sample User 52T a—-Y—oiEhl
1.From the Data & Services panel on the top right of 1. Fv>)\Z20ALICH3 [Data & Services] /¢
your canvas, expand Project Services. RILM5S. [Project Services] ZRERULZE I,
2 Right-click on UserAuthenticati d select Edit. 2. '"UserAuthentication" ZzH57Jwv U, Edit %z
N C.IC on. Ser u. entication and select £al ERUFE I, [Edit Identity Service (IDY—E
The Edit Identity Service window appears. ZDEE) 19+ > RUnERENET.
3.Click Import Users. The Import Users window 3. [Import Users] Z#22Uw2OULEXI. [Import
appears. Users] T > ROMKRRESNFET,
: . : 4. [TPAIN&E&ER] =0y IOULFEI., Tr >R
4.Click Choose File. The window explorer appears. THZFO—ShEmanEd.
5.Navigate to the location of the exportUsers.csv file, 5. BYICAI>0— RUJzexportUsers.csvJ 7 1
select the file and click Open. )/IJ/OJDi%Jj);(CE%)} LC. J71)L7%Z:ERUL. Open%z
: Jw 2oL o
6.Click Import. | 6. [BAK] 2OUvILET,
7.Waiting for imported user successfully notices 7. "Users Imported Successfully" BNERENET
appears. 8. [Edit Identity Service] D+ > RDZFHAUET,

8.Close the Edit Identity Service window.

' Copyright © 2022 HCL Technologies Limited | www.hcltechsw.com 25 L7 HCL SOFTWARE
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[Project Services] ZEHR

B voir Mx ris - x
Project Edit Build Debug Forge Window Help

& 41GXJ E Osamu Usui

DESIGN  frmR tDeta frmAccountlList fi R t fi R t fi t f P E DATA & SERVICES

BVR Apple-i0S : Native iPhone 11 (828 x 1792) Volt d ackend: RecipientsMobile t Refresh

LE SER'
> PROJECT SE|

[Data & Services] /\RILDS,
[Project Services] %= R

Add Sample User

- e Data & Services panel on the top
Default Library T ght of your canvas, expand Project Services
v Default 2. Right-click on UserAuthentication and ect
1 Edit. The Edit Identity Service windo

3.C Import Users. The Import Users wind

Open
6. Click Import.

DataGrid aiting for impo

Image s Recipients Balance

Label e Edit Identity Service

ListBox

Console Searc

Copyright © 2022 HCL Technologies Limited | www.hcltechsw.com 26 4= HCL SOFTWARE
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UserAuthentication Z62Uwv 2 0U. Edit Z#IR

B voir Mx ris - x

Project Edit Build Debug Forge Window Help

&acx) 2 & HCL Japan - osamuusui & Osamu Usui
DESIGN  frmR tDeta frmAccountList fi R t fi | t fi t f P E DATA & SERVICES

BVR Apple-i0S : Native iPhone 11 (828 x 1792) % olt d ackend: RecipientsMobile t Refresh —

@ Configure New \F) USE EXISTINg
L
(® Use Existing
UserAuthentication

> £) log Edit

i -
frmEditReci| 2y I unlink View Mapping lo gin Edit

=] frmRecipientDe 4 ! |‘-_J‘:]‘-_] ut Unl[nk

: UserAuthentication =52 w2 L.
R - Edit Z iR

v Default o wew wem | entication a
Edit. The Edit Identity Service
Click Import Users. The Import Users

s panel on the top
and Project Services

Console Searc Build Del

€Y 2ctions Saved [common] 5 I.\ tot

€ Project save suce ul .

exportUsers.csv f
Open
6 ck Import.

© rlugins download has started

€ Plugin download has been completed...

€ necipientsMebile : Live preview build complete. Time taken (in ms)
€Y rlatform wise codegen status:

€ iphone :

the Edit Identity Service

android :

€ code generation for project "RecipientsMcbile' completed.

Copyright © 2022 HCL Technologies Limited | www.hcltechsw.com 27 L’ HCL SOFTWARE




Edit Identity ServiceD s > R

B voir Mx ris -
Project Edit Build Debug Forge Window Help

Edit Identity Service

. RecipientsMobile 10~

Configure Services Manage Client App Assets Publish

& HCL Japan - osamu.usui ¥ Osamu Usui v

Identity Integration Orchestration Objects Workflow Rules Engagemen.
Identity Services / UserAuthentication (7

Add Sample User

ADD USER IMPORT USERS CONFIGURATION

ght of your canvas, expa Services

2. Right-click on UserAuthentication and select
Edit

3. Click Import Users. The Import Users

he Edit Identity Service
PHONE NO. STATUS GROUPS

Do llcore ore ouailonl 5.

exportUsers.csv

>wems| [IMPORT USERS] 2 U 2 i,

se the Edit Identity Service

Copyright © 2022 HCL Technologies Limited | www.hcltechsw.com
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exportUsers.csvZ&iEiR

B voir Mx ris
Project Edit Build Debug Forge Window Help

Edit Identity Service

Import Users

To import users, a batch file must be i 3atch files must be in .csv format and must conform
to the format as provided in the sample. That is, ders and same order a cified.

Download sample CSV file

Required Fields Optional Fields
Email Status

First Name Groups

Last Name

Password

Phone

T7A)ZER | exportUsers.csv

CANCEL IMPORT

(D7 A)V7&ER|ZOoUvOUT,
exportUsers.csvZiZIR L. [F<].
IMPORTZ 2w LET,

Copyright © 2022 HCL Technologies Limited | www.hcltechsw.com

Add Sample User

1. From the Data & Services panel on the to
ght of your canvas, expand Project Services
2. Right-click on UserAuthentication and ect
Edit. T

he Edit Identity Service appea
3. Click Import Users. The Import Users wind

5. Navigate to )
exportUsers.csv file, select the f
Open

6. Click Import

the Edit Identity Service

29
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B voir Mx ris - x
Project  Edit

Build Debug Forge Window Help

Edit Identity Service

. RecipientsMobile 10~

Configure Services

& HCL Japan - osamu.usui ¥ Osamu Usui v

Manage Client App Assets Publish

Identity Orchestration Workflow Rules

Identity Services / UserAuthentication (7

Integration Objects Engagemen.

Add Sample User

ADD USER IMPORT USERS EXPORT USERS TEST LOGIN CONFIGURATION 0

q ght of your canvas, e» Project Services
2. Right-click on UserAuthentication and select
Edit. The Edit Identity Service

The Import Users

3. Click Import Users

EMAIL FIRST NAME LAST NAME PHONE NO.  STATUS GROUPS

john.doe@woodburn.c...

John Doe active Members 5. Navig

exportUsers.csv
Open

> Advanced 6. Click Import

se the Edit Identity Service

@ 1 Users imported successfully

1 Users imported successfully &R =41,
d—Y—M1AEMMENEI,
INFILZERAUET
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Foundry 72U —33>0D)I\J Uy

WebJ SIYHY T, Volt MX Foundry Console (https://manage.demo-hclvoltmx.com/console/)
[CrPoALTOV1>

Volt MX Foundry Console X |

Volt MX Foundry Console 3

C ) https://manage.
€)
@ e | [PUbliShTRA > 2T D

Configure Services Manage Client App Assels PubTSh

m]
e
E2

L 1]
ae

1), Service & Web Client Native Client

@ V10000071000t (im] Volt MX Foundry Console x |+
. RecipientsMobile 6 VoltMX Sail
= C () https://manage.demo-hclvoltmx.com/console/#/apps/ff18a519-2a99-4796-80f0-3a621079a494/publish/servid}
% Custom Available
1.0 Osamu Usui 01 Aug 2022 09:41 UTC 1.0 N/A
. RecipientsMobile 10~
Configure Services Manage Client App Assets Publish
1, Service & Web Client Native Client
(im] Volt MX Foundry Console x =
° M100000710001 - a o
C ) https://manage.demo-hclvoltmx.com/console/#/apps/ff18a519-2a99-4796 %=
5
Available <) Snapshots
. RecipientsMobile 10~
Configure Services Manage Client App Assets Publish
——
Identity Integration Orchestration Objects vy “ @ Published ReciplentsMabile (v1.0) to M100000710001
@ \ @ Skipping publish of Engagement Services as they are not configured
j }R App Information
P u b I Is h / ; ;’a_ E i % Primary App Key 5474052b13384d21d82e927b615calcf
NAME URL [ ] [ P u b I I S h e d ] @ 5 (G EE nll.J\ Primary App Secret 6fb40¢7510aca29649088033e¢dbS20
Secondary App Key 573e6c05565692d832d493 1688784
UserAuthentication https//1000007 10.auth.de User Repository Secondary App Secret o TS
Service URL https://1000007 10 auth.demo-helvoltmx net/appeonfig

% ZDFIEE HikelCdBDFEEAN. PTUDOEMIERR TOT A > TS5 — 20T 3/zHCHETT,
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l o [ o= A=

XIRISEDRIIC Volt MXZJUDI L E1—ICDWNT

Volt MX App Preview can be run in 2 modes:

@ Running the application that's been
published on the Cloud
For sharing the app with others
You'll need to have the 5-digit code that is
created when you publish the application

@ Running the application locally
connecting to Iris using Wi-Fi or USB
For testing the application from their
desktop/laptop

Let see how to publish an Iris preview to the
cloud

' Copyright © 2022 HCL Technologies Limited | www.hcltechsw.com

Volt MX App Previewl(d.
2DDE—RTEITIBENTEET,

© ISIRLICAHETNETITVERTIS
VIV MDA EHETDIHE
7ITVT =23 2% UEBRICYERR SN S 54T
D1— RFHBETTY

@ Wi-FiX/zIZUSBTIrisiciE®mU. O—AHILT»
TU—>3>0%ET9D
SRAONYT /ST My ThBs7TU40—
> 3>T AN BRIEE

SE(X, Iris TLE1I—Z V35D RICAKHTBIHE
[EDVWTCTRTHELL S,
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(7/11) Volt MX App

Volt MX App

After logging in to the application, we can see
the various modes available as the menu items
at the bottom and by default cloud mode is
selected.

' Copyright © 2022 HCL Technologies Limited | www.hcltechsw.com
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[ CNEF1— NI TILOSERTY ]

EEFIRIRBEZSRUTLIZS0)

Volt MX App

Volt MX EIX\AIL7 TV —2 3> (01> 93
E. FEIDOAZ 31— [CHRRIRE— RHEKR RSN, T
JAILNTIEOTO RE—RMNEIRENTULET,
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Volt MX BNV UzEcgiLCcOd1>

19:09 9 all T %) 11:10 7 ull T @2

History

HCL Volt MX D

. Cloud Preview
0samu.usui@xxx.com

5 Digit App Viewer Code

manage.demo-hclvoltmx.com v | Forgot? Enter Code — 7 7" ) I/ I\t“ (g:

Cloud E— 7

BEIRESNTVET
J

SCAN QR CODE

ENTERPRISE LOGIN
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: - : CNEF1— NUTILOFERTY
(8/11) Publish Live Preview | St 2oy |

HikeTId USBI—J )L &#E# I 5EZHBLT
WEIH. SZTRISY RRIEZENXT,

Publish Live preview SAIITLE1I—&LHTS

1. From the main menu, select Build. 1. XA AZa—m5. [Build] Z&#RUET.
Click Publish Live Preview. [Publish Live Preview]| =2 Jw 2O UZET,

2. From the Publish Live Preview Settings 2. [Publish Live Preview Settings]> 1>
window, check the boxes next to the OS of T, 7TVZPEHITDE/IAILTINARD OS
the mobile device on which you are going to DIECHDFTYVIRY TRAZAZCUET,
publish the app. o EXIL I0SEANdroidiRETT,

For example, i0OS and Android.

3. Click Publish. 3. Publish z20Uvw 2O UET,

It may take some time for Iris to publish the Iris 77T V=N T DDICKEINANHNDIES
app. MN&HpDET,
The Live Preview is ready window appears. Live Preview is ready - > ROBKRREN.

‘ Iris gives you a 5-digit code. Iris M5 5 IO — RNFRENFET,
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B voit Mx iris

Project Edit Build Debug Forge Window Help

Run Live Preview Ctrl+R
Live Preview Settings

Customize Volt MX App

Publish Live Preview

Reset Live Preview ID

ative Local Ctrl+N
\c Publish Native Ctrl+B
Publish Web  Ctrl+P

DESIGN

BVR Apple-i0S : Native

[Build] > [Publish Live Preview]

72 1#4R

Copyright © 2022 HCL Technologies Limited | www.hcltechsw.com

(@

[Platform and Channels]
C Tl

[MOBILE] @

Platform and Channels

N

[J moBILE
& ios
Iﬁl Android
2R Windows
[J taeLeT
&€ ios
Iﬁl Android

28 Windows

Permission 0

Environment M100000710001 v9.2 Change

Preview Mode Debug [ ]

€)
[Publish]

Get HCL Volt MX @

Project Settings Cancel

~

pubﬁsh\"iOS"c‘:"Android"%%TR )

l o [ o= A=

-
@

StHiddd— kK&

QRO— RFMERKRENZET
-

N

Live Preview is ready.

1. Launch HCL Volt MX on your device

HCL Volt MX Iris

e

Get HCL Volt MX @

X

2. View your application

Enter the App Viewer code

OR

Scan QR Code

0520
T

Share via email

36 4= HCL SOFTWARE



(9/11) Launch the App

Launch the App
On your Volt MX App,

Enter the 5 Digit App View Code and
LAUNCH
or

Scan the QR code using ‘SCAN QR CODE’
button to preview the application.

' Copyright © 2022 HCL Technologies Limited | www.hcltechsw.com
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[ CNEF1— NI TILOSERTY ]

EEFIRIRBEZSRUTLIZS0)

7T UDiEH)
HIRTZD A TRDVolt MXFPITUT

S#Id7IJUE1I—d—RZEAAL

LAUNCH

=Sy i =
'SCAN QR CODE'7/R4 >TQRI— RZ&HEHHED,
7IUo—>3>aIlEal—-UFET,
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B2IJIWNF7IUT—S3 > oikE

1:249 ull T @2

History

ull T &3

D

Cloud Preview

To EXIT swipe two fingers from left to right

(FFUmET B
DHA REFR
ENFEY

@
5 Digit App Viewer Code Sﬁi'@:l - P%ljj
XXXXX ‘y

LAUNCH @
SCAN QR CODE

To view MENU hold two fingers on the screen for 2
seconds or shake the device

®
[X] &Z#5wv

</
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(10/11) View the App

View the App

You will now be able to view the app on
your mobile device.

1.Enter the following login credentials in your app:
« Username: john.doe@woodburn.com
- Password: VoltMX@123

2.Click Login.
The Accounts List appears.

3.Click Recipients.
The Recipient list appears.

In the Recipients list page, you can do the following:

« Click Add (+), to add a recipient to your account.

 Select a recipient from the list to view their details.

- From the details page, you can edit or delete the
recipient.

To exit the mobile app, swipe two fingers from left to
right or shake your mobile device and click Exit App.

' Copyright © 2022 HCL Technologies Limited | www.hcltechsw.com
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CNUFFa—MUTILOEIERTT
EEFIEIRBEZESR U TLIZS)

77UERUTHSB

CCEFTODFIRICEKED, B/INAILT/INARTP7TVEFRRTSE
BDEDICIRDFET,
1. PZTUCAToOTAEHREANDLTIIZE,
- J1—Y—%: john.doe@woodburn.com
. JXAJ— RK: VoltMX@123
2. [Login] Z#Z0Uwv O UET,
"ACCOUNTS"H'ETRENFET,

3. [Recipients] Z#20UJUwv2JUFET,
"Recipients List"N'FxRrRENET,

"Recipients List"R—=T(d. U TDIRIENBIGETT .
EBI(+H)Z0UYOULT. ZMEBZI77HD> MIEN
DX M SREBZEIRL. TOFMZRTR
- FHNR—T. RMEBDRETHIBR,
TINAIL T TUZEETITBICIE 2RIEZENSAICRDTAT
93N B/\AI)LmEK=ZiIR>T. [EXxit Appl Zz0UwvoOUZE

ER
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7IV&HUTHDB

19:55 7 ull T & 20:57 9 ul T @

EXIT PREVIEW O RESET

20:57 9 al T @

EXIT PREVIEW O RESET EXIT PREVIEW O RESET

ACCUUNITS =

< RECIFPIEN TS LIS | -

4 )
@ My Savings $42,304 John Doe
1—

B —%: john.doe@woodburn.com || . 22500 e
} lej_ I<: VOItMX@ 123 Arthur Morgan

/ My Savings $32,761 +1(650) 555-300

/

My Deposits $12,000

john.doe@woodburn.com

@

HED/\—%&

R=w/o U TEE)
"

| <> NG o
VIEW SOURCE Accounts Recipients Balance More
—— ————

VIEW SOURCE
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(11/11) Congratulations

Congratulations

You have successfully:
* Imported a mobile app

- Launched the app on a mobile device using the Volt
MX App

To learn how to create this app on your own, check
out the next hike:

2. Create Ul from Collections

' Copyright © 2022 HCL Technologies Limited | www.hcltechsw.com
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BHTESTINET !

HREIFUATOZ EICKRIILE U,

« EBINMINTTUDA >ik— b

- Volt MXZ2U%ZERLT. E)\1IF)I\A/1 XL
TP’V ZicE,

CHO7TIEBDTVERR T DEICDWVNTIE. XD
INADOESIBLTLIEEL)

2.L923>hB5UIZENRT D
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Wi-FiX/Z(FUSBTIrislCiEHRU. O—NITPIVUZEFTITIIHS
Flad (7/11) ~ (9/11) HERDZET,
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(7°/11) Volt MX App (O—hILDIBE) | Ao, |

Volt MX App Volt MX72'U

1.Connect your mobile device to your computer using 1. B)\AimRZUSBS — )L T/ WY 2 (T
a USB cable. L&, o
For Android mobile devices, ensure that the user of AndroidimR DS, USBOERED J7 1)L
USB i Transfer fil ' BLX(CERESN TWVWD T EZMERUE T,

IS setas Transter files. OSE/\AMILTNA ZRDBEF. T/ RETS

For iOS mobile devices, ensure that trust has been E 1 —ADEHEBGHEI SN TR S &hE
established between your device and your =B L,FE9., (WindowslZiTunesh iETI)
computer. 2. E/XAILT/NAXTVolt MXFPTUZREN L E

2.Launch the Volt MX App on your mobile device. 9,

3.Select the USB tab. 3. LiSE’gj’iETR LEI.
On a successful connection, Volt MX Iris on your kNI S L, B3 —5 FdDVolt MX
computer shows a success prompt. Iris(@RINIDT O T bR UET,

4, AAZAZa1—H5. [Build]=:EIRUET,

4.From the main menu, select Build. ] - ]
[Live Preview Setting]|Zz2oUw 2o ULET,

5.Click Live Preview Settings.
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Windows [C i0OS%Z& USBiEfi J Di5a iTunesh B ETT

BE : Windows< > > TDiosT /1 ADUSBTHU >

BIIESRME - Windows < = > (CEFT/\—=3 > DiTuneshV 1 > A —)LENTL)
D EEMERUTLIZEEV, Volt MXTZ7 U DUSBEERE & {E D TiosT/\1 X T
T A MZRIE I BEIC. Windows~< > > DiTunesZ W TLIZEL),

Important: USB Tethering for iOS devices on Windows Machine:

Prerequisites - Ensure that the latest version of iTunes is installed on the Windows
machine. Before you start viewing the app on your iOS device by using the USB
feature on the Volt MX App, open iTunes on your Windows machine.

“« b » [ =) [aw= ) - 25
TAILF) fREE BS) TV JXRO-LO PHOYRA) ALTH)

< 7 z3-9vs ¢ [ ForYou R2H&d 3SIY%  ART
5175
A T-T4Ak
T
J i

W s

FIMR

1—
v [] Qsamut, .

€2 Bmusic : . -0
= i Appls Munls Payiines o
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—HIILTDVolt MXF7ZIUDFTA b

B volt MX Iris

Project Edit Build Debug Forge Window Help
Run Live Preview Ctrl+R
Live Preview Settings

Customize Volt MX App

Publish Live Preview

Reset Live Preview D

Build Native Local Cirl+N
Build and Publish Native Ctrl+B
Build and Publish Web  Ctrl+P

Volt MX App

Default Library
v Default
: FlexContainer
: FlexScroliContainer
Tab

TabPane

Console

Copyright © 2022 HCL Technologies Limited | www.hcltechsw.com

lick Live Preview Settings

-osamu.usui & Osamu Usui

Preview Settings]

v General

ID frmAccountList
Render Edit

Friendly Name

ntroller frmAccountListController

Volt MX Iris or
ess prompt
t Build

45
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(8’/11) Run the App (O—AHILDIEE) [4%“%?55?5552%%1@???3\]

PIV&ERITID

Run the App

1.From the Live Preview Settings window, 1. [Live Preview Settings]o-r > ROM5,

under Native, check the boxes next to the OS
of the mobile device on which you are going
to view the app.

For example, 10S and Android.

Ensure that you have unselected the
checkboxes for all the other platforms and
channels.

2.Click Save & Run.
It may take some time for Iris to run the app.
The Live Preview is ready window appears

' Copyright © 2022 HCL Technologies Limited | www.hcltechsw.com

[Native] OF(CHd. 7TUEKRRIDE/N
1 ILT)\A ADOSDIE(CdH BNV I XICFT WV
DEANET,

HZ(E. 10SY°Android/:&E T,
DI RTDITSY R ITA—=—LEFVHRILD

F 1w IRy DRADERNEEIRESN TS &
MR UET .

[Save & Run] =0 Uw IO ULET,

Iris M7 T U REITI DX TICRR—ANAHMINB5
e DET,

Live Preview is ready (57J JL E1—®D
H@NTEELRLE) Da 2 ROMKRRENET,
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Live Preview Settings
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B volt MX Iris
Project Edit Build Debug Forge Window Help

Live Preview Settings

Platform and Channels

-} RESPONSIVE WEB

NATIVE  ADAPTIVE WEB

0 mosiLE

[Platform and Channels]

Z ZTld [MOBILE] @

"iI0S” & Android"ZiEIR L T
Save & Run =z U w7,

E)L RICEZVEFR-IAADIDET,

)

& os

= .
W Android

<<}

58 Windows
[ TasLer
& os

- .
g Android

Run the App

=R Windows

1. From the Live Preview Settings window, under
Native, check the boxes next to the OS of th
mobile device on which you are going to vie

Environment M100000710001 v9.2 Change

Preview Mode Debug Clean Preview

Get HCL Volt MX For example, iOS and Android

Ensure that you have unselected the

channels
2. Click Save & Run

Project Settings Cancel Save

e Live Preview is fEid‘,’ 1dow appears

8/11
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USBI¥E#: UK (& Wi-Fi ZHTHEHAIEE(C

B volt MX Iris = b
Project Edit Build Debug Forge Window Help

Live Preview is ready.

1. Launch HCL Volt MX on your device 2. Connect your device

Connect with USB

OR

-
Connect with Wi-Fi

HCL Volt MX Iris
Run the App

Scan QR Code
App Name: RecipientsMobil 1. From the Live Preview S
€ Native, chec :
mobile de

IP Address: 172.19.32.1
Port: 9989

Get HCL Volt MX

Don't show this again
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[ CNEF1— NI TILOSERTY ]

(9°/11) Launch the App

EEFIRIRBEZSRUTLIZS0)

Launch the App I UDikEH)
On your Volt MX App, click Launch. Volt MX 72’V T. [Launch] Z0Uwv 2O UZEY,
You may see an Application Name input box. IS —,3 DAY I ZINEREINDBIE
If there is an input box, EherNE,
enter RecipientsMobile and then click Launch. ATRY I ZNNHBEE T,
[ RecipientsMobile] & AZU. [Launch]ZzZ©
w2 UFRT,
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[[Launch]’i/ﬂ\yj’] [

1—Y—%: john.doe@woodburn.com
JXXJ— R: VoltMX@123

¢ @59% %)

@ 11:27

all au

C @58% @)

@ 11:27

To EXIT swipe two fingers from left to
right

Connected to workstation

Searching

Run the App in Iris to preview

LAUNCH

Cancel

To view MENU hold two fingers on the
screen for 2 seconds or shake the device

RecipientsMobile

LAUNCH

S HA REBRLS

7 TUaANZEKROSNIZIHZE (T
[RecipientsMobile]Z A1 LT
[LAUNCH]Z4& v

Wi-Fi Cloud
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¢ @ 60% %)
() RESET

john.doe@woodburn.com

«BRMT

VIEW SOURCE
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USBiEf#t CETLVRLY
BEIECDERRTT

¢ @ 60% %)
() RESET

@ 11:32
EXIT PREVIEW

—

My Savings $42,304
My Checking $22,503
My Savings $32,761 @
My Deposits $12,000 !

Connect to your workstation using USB

[77Uﬁﬁﬁ]

VIEW SOURCE
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Wi-Fi DS

MANUALLY ADD THE WORKSTATION

IP Address
192.168.11.13
Port
9989

RecipientsMobile

SCAN QR CODE

[Wi-fi]5 T

(TrisiCERE=NE
IP 7 RLZ &
R NEAD

[ RecipientsMobile]
EANLT

[CONNECT] /

Copyright © 2022 HCL Technologies Limited | www.hcltechsw.com

MANUALLY ADD THE WORKSTATION

IP Address
192.19.32.1

Port

9989

SCAN QR CODE
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VoltMXDTD/T A X

£ TOISLELUY-ER UE-F IV¥1-4-
FORINESUR-t  23-F  #@HRE 00 FUVOL  UE-R Y-
FarBLUR—+

e JORJDTESRE:  TCP
ZokanES 6 -

o=hil A=HL: HEOR— b

9989

41 80, 443, 5000-5010
Y-k A-NR FTATOHR— b

{1 80, 443, 5000-5010

Ah—y MliflAvtz -3 2ok
(ICMP) MERTE:

4 N

Wi-fi # &80 T E/R0)
BAFCOFERCY

R— SOBIATIAR
R EERER LT
/

=)
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